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I.  Introduction

The Colored Two-dimensional Bar Code (C2DB) is a variation of the popular two-dimensional bar codes. It is a two-dimensional array of colored dots that can contain a high data density in a small physical space.  The addition of color to a two-dimensional bar code effectively adds a third dimension.  It can store more than 24,000 characters is a space that is only 130 mm x 40 mm.  C2DB has an error-tolerant design that can withstand a considerable amount of damage and distortion.  Some of the parameters surrounding the implementation of the C2DB are still as yet undefined.   The purpose of this work is to investigate some of these parameters involved in C2DB, mainly the distribution patterns, and to find optimal values for them. 



This paper is the last of three on this subject.  The first paper [2] focused on the specification of a program that could be used to evaluate the C2DB symbol and its various parameters. The second paper [3] was oriented more toward the detailed design of the program specification proposed in [2].  It also included an initial implementation which consisted of a good amount of the total functionality.  This paper continues the implementation by incorporating important design features and later attempts analysis of symbol parameters using the resulting program.



The paper is organized as follows. Section II is the user documentation needed to use the C2DB program.  Section III includes the design enhancements done since [3].  These enhancements include the addition of compression, error correction and several new distribution patterns.  The section also includes information on the source code and how it may be compiled.  Section IV contains the analysis that was done to investigate some of the parameters that are not well defined around the C2DB structure, specifically, the distribution patterns.  Section V is the conclusion and Section VI contains references.



II.  User Documentation

The C2DB program is like many Windows programs such as word processing, presentation and spreadsheet packages in that it is document-centric.  The document in the C2DB program is the C2DB symbol.  The C2DB symbol that is loaded at any given time is referred to as the ‘active’ C2DB.  The C2DB program allows symbols to be created with a variety of parameters, decoded to get their original contents and compared with a data source assumed to be the original they were created from in order to determine how accurate they remain.



There are four pull down menus in the C2DB program; File, Actions, Options and Help which control all of the functions of the C2DB program.



II. a.  The File Menu

The File menu allows C2DB symbols to be created, opened, saved and otherwise manipulated by the program.  The operations available off of the File menu are in Table 1.



Note: When creating new C2DB symbols, files that are known to be compressed such as graphic files and archive files like .zip files should not be run though the C2DB program using it’s compression mechanism.  In some cases this can actually cause the size of the data in increase!  This was not particular to the C2DB program but happened in general when using the compression algorithm used by the C2DB program on  files that already used some compression.

�

File command�Function��New�Allows a new C2DB file to be created.  The user is first prompted for the name of the new C2DB .bmp file.  Next, the user is prompted for the data file to create the C2DB with.  Third and lastly, the user is prompted for the parameters to create the C2DB with.  The parameters are the number of columns (in codeword chunks), the error correction level (0 to 7), a compression flag, the distribution mechanism and the number of colors.��Open�Opens an existing C2DB file and makes it active.��Save�Saves the active C2DB.��Save As�Saves the active C2DB under an alternate file name.��Close�Closes the active C2DB.��Print�Prints the active C2DB.  The output can go to paper, labels or any stock that can be printed on by a system attached printer.   It also has the capability to allow a Print Preview for examining the layout before printing and a Print Setup for setting various setting surrounding the Print such as orientation (landscape vs. portrait), printer to use, layout of page, etc. ��Exit�Exits the C2DB program.��File Menu Options

Table 1



II. b.  The Actions Menu

The Actions menu allows operations to be performed on the ‘active’ C2DB symbol.  The Actions appear in Table 2 with their descriptions.



Actions command�Function��Decode�Decodes the active C2DB and produces a data file as output��Compare�Compares the active C2DB with a data file.  This will be useful when evaluating the robustness of a damaged C2DB.  The output produced will be the percentage of the symbol that can be decoded and the number of errors that were detected.��Actions Menu Options

Table 2



II. c.  The Options Menu

The Options menu allows user interface features to be turned on or off.  These are the display of the codeword in the Bitmap Values grid and the display of the distribution pattern in the Codeword Distribution grid.  Displaying these ‘visualizations’ slows down performance of the program so the option allows them to be used only when desired.  Both options are unchecked by default.



Options command�Function��Show Codeword�Displays the codeword data values in the Bitmap Values grid.��Show Distribution�Display the distribution pattern in the Codeword Distribution grid.��Options Menu options

Table 3



II. d.  The Help Menu

The help menu provides help in the typical Windows help fashion.



II. e.  The C2DB Window

The C2DB Window has been designed with a three-paned approach.  It consists of the Bitmap Values pane, the Message Log pane and the Codeword Distribution pane.  The Bitmap Values pane shows the currently active C2DB as its representation of data values.  The window has scroll bars which allow navigation around  the bitmap should it be larger than the pane can show.



The Message Log pane provides feedback to the user on the current operation.  The feedback can be in the form of a reiteration of the parameters used to create a C2DB, the time it takes to decode or encode a C2DB symbol, information about the C2DB or data files themselves, or, on a comparison operation, a statement of the correctness of the C2DB symbol.  This will be very important for using the program for analysis.



The Codeword Distribution pane displays how the codeword chunks are distributed in the current C2DB.  Each location in the matrix shows a value x.y where x is a codeword and y is a chunk within codeword x that holds that position.  This pane is useful for visualizing the effect of the distribution scheme chosen and seeing any problems it may have introduced such as chunks of the same codeword being too close to each other.  Codeword ‘h’ is used to represent the header.



II. f.  Limitations of Current Design

The Print menu items are not functional.  No logic has been added to allow printing of the C2DB symbol.

The Help menu is also not functional.  Help information is provided via this document.

The number of colors used in the C2DB symbol is currently fixed at 16.



III.  Design

The design is essentially the same as described in [3] with a very few modifications.  Many features that were missing in [3] have now been added.  These are compression, error correction and codeword distributions in addition to Row-major order.  Testing and design changes were also done to validate that the program worked not only with text files but with all files, binaries included.



III. a. Compression

The work done in [1] included compression using the Lempel-Ziv algorithm.  The source code from [1], as provided, compiled and ran fine with Microsoft Visual C++ 4.2 except when the compression feature was used.  Use of the compression feature generated a memory fault and halted execution of the program.  It was decided to use an alternate algorithm found on the Internet [4] instead of troubleshooting the existing, uncommented code.  Also, the existing algorithm must have been incorporated from a standalone program since its processing was file oriented and still used an intermediate file in its computations.



This piece turned out to be a fair amount of work.  The existing algorithm [4] was written in ‘c’ for an unknown compiler so some functions had to be translated into corresponding Visual C++ functions.  It also was oriented toward file I/O much the same was the algorithm in MDB [1] must have been.  It was decided to convert this from file-based operations to CString-based operations.  (Note: CString is an MFC class that is a string of chars with many methods and properties that make them very easy to work with without having to deal extensively with pointers.  I have used them a lot in the C2DB program.).  Also, the ‘c’ implementation was converted to an object-based C++ implementation to fit better into the C2DB structure.



III. b. Error Correction

The Reed-Solomon Error Correction as implemented in MDB [1] was incorporated as a whole.  This saved much time on the implementation.  Some minor tweaks were made to the code in order to integrate it.



Error Correction is defined in eight levels from none (0) to very robust (7).  The header is encoded with a separate level of error correction from the rest of the C2DB codewords.  It is encoded at the most robust level (7).  This is possible because it contains very little data.  Under error level 7, 151 data values exist in the codeword and the remaining 104 are used for parity.  The header codeword only contains 6 bytes of meaningful data.  The 6 bytes is made up of two bytes for the data size, another two bytes for actual data size (which differs from the data size when compression is used), one byte for the compression and error level indicators (4 bits each) and the last byte for the distribution pattern.



In [2], a reference was made to information in [1] about the number of data characters and checksum characters per error level.  [1] did not include information on all levels only 0, 1 and 7.  [2] extrapolated those values to get information for the remaining error levels.  The implementation done for MDB as part of [1] which has now been obtained had the information on all levels coded in it.  As it turns out the extrapolation was entirely accurate.  It is now presented again here in Table 4 for completeness.



Error Level�Data Characters�Checksum Characters�% Data Loss��0�255�0�0��1�223�32�6��2�211�44�9��3�199�56�11��4�187�68�13��5�175�80�16��6�163�92�18��7�151�104�20��Definitions of Error Correction Levels

Table 4



III. c.  Distributions

The implementation in [3] had only one type of distribution, the row-major order, where codeword chunks are laid in order.  This scheme allowed for the first chunk of the header codeword to always appear in the same place (lower left) in every symbol regardless of symbol size.  (Note: the lower left of the graphical representation of the symbol corresponds to the upper left of the symbol data since, in the DIB, data is stored last row to first, not first row to last).  Since the header has so little data, it could fit in one chunk (15 bytes) of the codeword so the header data could always be found as the first chunk in the data.  The implementation in [3] also had no error correction added so the loss of that one chunk meant the whole symbol was unrecoverable. 



Now, with new types of distributions and error correction for the header it is no longer safe to assume the header data is contained in the first codeword and only in the first codeword.  A structure needed to be determined to place all of the header chunks into the symbol so that each and every one could be found with little information about the symbol other than its physical size.  An algorithm to scatter the header chunks based solely upon symbol size was created.  The header distribution is always the same and can and will differ from the codeword distribution.



III. c. 1. Header Distribution

This used a simple mathematical formulas that would first take the 17 chunks of the header and equally divide them among the rows of the symbol.  Depending upon how many rows the symbol has this may turn out to be greater than one header chunk per row or less than one header chunk per row. Table 5 contains the row distribution that was calculated for the header of a symbol of 10 columns (chunks) and 12 rows which contained 7 codewords including the header.  This sample symbol will also be used in several following examples.  The last column of Table 5 shows part of the formula used to calculate the number of header chunks in a row.  The result of this formula will equal the number of chunks placed so far, including the current row it is calculated for and all preceding rows.



Once this distribution is determined the chunks are placed in columns of their assigned rows.  The column assignment is done using a second formula so that header chunks are staggered throughout the symbol.  This is done by placing each at a column that is some offset away from the column positions of the chunks in the preceding and succeeding rows.  The offset is based upon the number of columns in the symbol and the maximum number of chunks the header may have in any given row.  This seemed to work well for symbols of any size and never resulted in header chunks lining up in a row or column.  At worst chunks are no more than two positions away from each other.   An example of a header distribution with an offset of 2 is shown in Figure 1.  



Row�Number of Header Chunks�int((17/ no. rows) * row)��1�1�1��2�1�2��3�2�4��4�1�5��5�2�7��6�1�8��7�1�9��8�2�11��9�1�12��10�2�14��11�1�15��12�2�17��

Header Chunk Distribution per Row

Table 5



The distribution shown comes directly from the Codeword Distribution pane where the codeword chunk represented in each cell is an x.y pair where x is the codeword and y is the chunk of codeword x.  Note: the display make look upside down; the lowest order chunks are at the bottom and higher order chunks are at the top.  Since the data is in DIB format it follows a structure of the DIB where the data is stored last row to first.  So, when a program writes to the first row in the DIB data buffer, this will appear as the last row when the symbol is viewed graphically.  In order to create a distribution table that accurately maps to the graphical representation we show the data in the table in this ‘last to first’ order.



�

Example of Header Distribution

Figure � SEQ Figure \* ARABIC �
1
�



III. c. 2. Row-Major Order Distribution

The remaining distributions are the old familiar Row-Major Order and two new ones called Custom and Pseudo-random and are used to distribute the data codewords.  Row-Major order lays into the symbol all of the first chunks of each codeword followed by the second chunks of each codeword and so on until all 17 chunks of each codeword have been processed.  This, of course is done for only the data codewords as the header codewords are left in place and their positions skipped by this process.  An example of the Row-Major order distribution is shown in Figure 2.  Note that the header positions are as shown in Figure 1 and all data chunks appear in Row-major order around them.  Again as noted for Figure 1, data is shown in the last to first order as it would appear should the symbol be viewed as a graphic.



�

Example of Row-Major Distribution

Figure � SEQ Figure \* ARABIC �
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III. c. 3. Pseudo-random Distributions

Pseudo-random is a mode that distributes the chunks in a random fashion around the header chunks.  It is prefixed by ‘pseudo’ because the random numbers used to distribute the chunks are static, i.e. they do not change from one execution to the next.  This is because distributed chunks can only be recovered if the random numbers used to distribute them are known.



�

Example of Pseudo Random 1 Distribution

Figure � SEQ Figure \* ARABIC �
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A list of numbers that was generated randomly is contained within the program.  Enough random numbers exist to allow the number of chunks that make up the maximum symbol size to be placed.  To place a smaller number of chunks a subset of the list of random numbers is created that contains only the number necessary to place that amount of chunks.  Each position (row, column) in the symbol’s data buffer is assigned a number from left to right, and continuing for each row from top to bottom, like reading a page.  Codewords are taken a chunk at a time; chunk 1 of codeword 1 goes into the position identified by the first random number, chunk 2 of codeword 1 goes into the position identified by the second random number and so on until all chunks of codeword 1 have been placed.  This then continues with codeword 2.  If a random position identifies a place where a header chunk already exists the position is skipped and the next random number is used.



There are three Pseudo-random distribution modes each with a different set of random numbers.  Three were included to study if there was any benefit in one set of random numbers over another.  Also,  this eliminates the possibility that the single set may not be particularly well suited for the task.



III. c. 4. Custom Distribution

Custom distribution takes the mechanism used to distribute the header described above and continues with the same strategy to distribute all codeword chunks. Codeword chunks are first distributed evenly by assigning them to rows of the symbol.  Depending on the number of codewords and the number of rows this distribution may vary from more than one chunk of a particular codeword per row to less than one.  An example is shown in Table 6.  The distribution taken for the header is used for each successive codeword by shifting it one row position higher.  Chunks are then placed in each row starting at an offset from the previous row.  Header chunks that are already placed in a row are skipped as with other distributions.  This mechanism was tested successfully for symbol widths from 3 to 255 chunks and for symbols containing from 3 to 255 codewords and every combination thereof in order to verify that it would work and no row would overflow with chunks.



�Codeword��Row�Header�1�2�3�4�5�6��1�1�2�1�2�1�2�1��2�1�1�2�1�2�1�2��3�2�1�1�2�1�2�1��4�1�2�1�1�2�1�2��5�2�1�2�1�1�2�1��6�1�2�1�2�1�1�2��7�1�1�2�1�2�1�1��8�2�1�1�2�1�2�1��9�1�2�1�1�2�1�2��10�2�1�2�1�1�2�1��11�1�2�1�2�1�1�2��12�2�1�2�1�2�1�1��Codeword Chunks per Row for Custom Distribution

Distribution pattern starts in italicized row

Table 6



An example of the Custom Distribution is shown in Figure 4.  In this example, one chunk of codewords 2, 4 and 6 and two chunks of codewords 1, 3 and 5 are assigned to the first row to be built (Row 12 of the symbol).  First a chunk of each codeword that appears in the row at least once is placed in numerical codeword order.  Next chunks from each codeword that contains at least two instances in the row are placed in numerical codeword order.  Processing continues in this fashion for ‘x’ iterations until all codewords that have at least ‘x’ chunks are placed and no codeword has ‘x+1’ or greater chunks in the row.



The second row is then processed.  Placement begins at an offset from the previous row.  This offset is the same that was calculated when placing the header.  In this case it is 2.  First all chunks of  codewords that appear at least once in this row are placed.  In this case it is all codewords 1 through 6.  Next, chunks of codewords that appear at least twice are placed.  In this case this is codewords 2, 4 and 6.  Processing stops here for this row since no codeword has three instances or more in the row.  This continues until all 12 rows have been filled. 



If the end of a row is reached during placement,  processing continues by wrapping around to the start of the row in column 1.  Care is taken to make sure that no row will ever have more chunks than the number of columns in the symbol.  Although, some rows may not be fully filled with chunks.  For an example see row 6 of Figure 4.  Column 2 of row 6 is empty.  Empty chunks will not always appear at the end of the row.  This depends on the offset where the placement started.  In the case of row 6, placement started at column 4.





�

Example of Custom Distribution 
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III. d. User Interface

The user interface exists as described in [3] with a few minor exceptions.  The Codeword Table is not a graphical representation.  It is a table of the data values that make up the graphical representation.  This was more valuable during development, testing and debugging of the program and time was not available to convert it to the graphical representation. 



Secondly, and partly due to the long delays associated with creating the tables since they use OLE, two new options were added.  These appear under the new Options menu and are ‘Show Codeword’ and ‘Show Distribution’ which are checkable items which toggle on/off the population of the two tables.  Disabling both of these speeds processing time dramatically.  These two tables were used extensively during the debugging of the code and are left in as an aid to the user when familiarizing himself with the symbols.



III. e. Source Code 



Important Files that are part of the C2DB project and their purposes are detailed in the table below.  These files are included in the distribution file, C2DB.exe.  C2DB.exe is a self-extracting zip file which can be decompressed without a compression program like pkzip or WinZip.   Double-click the file.  You will first be prompted for a directory in which to extract the files.  The default is ‘c:\C2DB’.  Change it if so desired and finish by clicking the Unzip button.



Files(s)�Purpose��C2DBDlg.h

C2DBDlg.cpp�This is the code for the main dialog box and is the core of the processing.  All functionality based upon the user commands is driven from here.��CDataFile.h

CDataFile.cpp�This object holds the data that will get encoded into the symbol or decoded from the symbol.  It has operations for inserting and extracting data from its buffer.  It also handles data compression.��CCodeword.h

CCodeword.cpp�This object holds one codeword of the C2DB symbol.  There are two types of codewords, headers and data codewords.  This object has a base class, CCodeword with the common functionality of the two and two subclasses, CDataCodeword and CHeaderCodeword with the specifics for each.��CC2DBFile.h

CC2DBFile.cpp�This object holds the C2DB symbol.  It handles data insertion to and extracting from the symbol.  It also handles distributing the codewords based upon a map that is built.��FileNewDlg.h

FileNewDlg.cpp�This is the code for the dialog box that appears when File >> New is selected.��CCompress.h CComp.cpp�This code is an adaptation of the Lempel-Ziv compression and decompression algorithms as implemented by Kent Williams, Norand, Inc., 550 2nd St. SE, Cedar Rapids, IA 52401, 319 369-3131. 



It has been modified from its original form to take as input and produce as output objects of type 'CString' rather that file objects.  It has also been converted from two standalone programs, one for compression, one for decompression, of procedural type into one object-oriented class implementation.��MYFILE.CPP

DIBAPI.H

DIBAPI.CPP�These files were taken from the code samples that were part of Microsoft Visual C++ package.  They allow DIBs to be written to disk, read from disk and otherwise manipulated.  They have not been modified here.��Er_pr.h

ER_PR.CPP�The Reed-Solomon error processing has been taken from the implementation of the MDB program [1].  They have not been modified in any way.��C2DB.mdp�Visual C++ Project Workspace��Distribution Files in c2db.exe

Table 7



III. e. 1. Compile Requirements

The source code was developed with Microsoft Visual C++ 4.2 under Microsoft Windows 95.  It should also compile under later releases of Visual C++ and under Windows NT 4.0 but this has not been tested.    Also, for the tables (implemented via OLE Grid Controls), it requires Grid32.ocx to be installed and registered with the Windows Operating System.  Grid32.ocx comes with the Visual C++ package along with instructions on how to install it.



To complile the source code, open the Project Workspace (c2db.mdp) extracted from the C2DB.exe file with Visual C++.  From the Build menu, select ‘Build C2BD.exe’.  To run select ‘Execute C2DB.exe’



III. f.  Known limitations

Along the lines of the specification, which states that 24,000 characters can be encoded into a symbol, size limits were coded into the C2DB program.  The maximum data that can be encoded into a symbol is 12288 bytes (12 Kbytes).  This limit includes the effects of error correction and parity and the bytes they add or reduce, respectively.  At error correction level 7 where 104 of every 255 bytes codeword is allocated to error correction parity bytes, the maximum input data set is a little over 7Kbytes.  With compression assumed at 3:1, 21Kbytes can be encoded in a single symbol at error correction level 7.  Without error correction and compression assumed at 3:1, 36Kbytes can be encoded in a single symbol with the current implementation.



Most of the memory leaks were cleaned up from the initial implementation but one annoyance remains that is not known to be caused by a memory leak but its behavior is of one.  When using the File >> New command repeatedly, the C2DB program will freeze after the Save As dialog displayed as part of the File >> New process.  It was found that the program will not freeze during repeated File >> New processes if the files that are specified already exist and get replaced.  Other than this one exception, the program was very stable and was stressed during the analysis phase as dozens of file were created, opened, saved and compared.



IV. Analysis

The purpose of this project was to identify which distribution mechanism is the most robust.  Robustness means that the error correction mechanism can recover the symbol when it is damaged.  Robustness may be compromised by poor distribution of codeword chunks where chunks of the same codeword are too close or line up in some way so that only a small defect can destroy an entire codeword.  The objective is to find a pattern that allows the local defect to be spread across many different codewords whose checksum bits can be used in conjunction to make the defect seem effectively smaller.  The pattern must work for codewords of many different sizes and shapes.



All work done up to now has just been to facilitate this effort.  To study this, data was encoded into C2DB symbols using various levels of error correction both with and without compression for each of the distribution types.  Next, errors were introduced into the symbols to simulate defects that might occur in the physical world.  An external graphics program was used to do this.  This program was Paint Shop Pro by Jasc, Inc.  Any graphics editor including Windows Paint could also be used to do this.



The simulated defects came in several categories; scratches, marks, holes and cuts.   The testing methodology was to introduce the defects first at a small size and then to increase the size and evaluate the effect on the symbol.  Once 
the defect was large enough so that
 all
 of the data could not be accurately recovered the test was halted and the threshold was recorded.  Threshold
s
 between like symbols with different distribution patterns are then compared to determine the effectiveness of each
 pattern
.



The data file used throughout all of the tests was the same.  It was a text file that was 7201 bytes in length.  This size was chosen because at error correction level 7 with the added bytes for the checksum it falls just below the size limit for symbol data.



IV. a. Scratches/Marks



Scratches might occur when the symbol comes in contacts with a sharp object.  They are typically long in length and narrow in width. Marks would be produced by an object rubbing the symbol or from a writing instrument such as a felt tipped marker or pen.  Marks are typically short in length and wide in width.  To test the effects of a mark or scratch
 a line 
was drawn on the symbol 
at one pixel wide 
and then made increasingly wider until the error correction mechanism could no longer recover all of the data accurately.



�

Example of Mark Applied to Symbol 

Figure � SEQ Figure \* ARABIC �
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Various symbol sizes and error correction levels were used in the evaluation of the effect of scratches and marks.  The parameters for the symbols tested are contained in Table 8.  Each symbol was tested with the identical defect under each distribution type.  The defect was a line of length 151 pixels that was introduced into each symbol at a diagonal.  The width of the line was increased as described previously.   The results of the tests are shown graphically in Figure 6.  Since each symbol uses a different error correction level comparison between the results of the
 test cases
 may not show much but the comparison within each
 test case
 results 
can be
 revealing.



Test Case�Symbol Columns

(in chunks)�Error Level�Number of Codewords�Symbol  Width

(pixels)�Symbol Height

(pixels)��1�3�2�36�90�204��2�10�3�38�300�65��3�13�7�49�390�65��4�17�1�34�510�34��5�23�6�46�690�34��Parameters for Symbols Used in the ‘Scratch/Mark’ Test

Table  8



Two sets of  parameters were picked in attempt to expose problems with the Row-major distribution.  These were the cases where the symbol width is 17 and 23 columns in test cases 4 and 5, respectively  They are potential weaknesses since the number of codewords is a multiple of the width of the symbol.  This causes chunks of the same codeword to line up in columns.



Row-major order did well in all cases except Test Case 5 mentioned above which was designed to challenge it.  It did well because the scratch was more horizontal than vertical.  The chunks were lining up in the vertical direction.  The Custom distribution order was the leader in performance in all cases except when the symbol became very narrow.   The Random distributions had average performance.



� EMBED Excel.Chart.5 \s ���
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A second scratch was applied to the symbol 
of
 different sizes to see its effect.  The scratch was more of an arc than a straight line.  Also, for each symbol size
,
 the error correction level was held constant in order to focus on the effect of symbol size only.  The arc was introduced at 1 pixel wide and made increasing wider until the error correction could no longer recover the symbol at 100% accuracy.  The symbol parameters tested are in Table 9.  Each symbol was tested under each distribution pattern and the results are shown graphically in Figure 8.





� EMBED Word.Picture.6  ���

Example of Arc-shaped Mark Applied to Symbol
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Test Case�Symbol Columns

(in chunks)�Error Level�Number of Codewords�Symbol  Width

(pixels)�Symbol Height

(pixels)��1�9�2�36�270�68��2�12�2�36�360�51��3�15�2�36�450�41��Parameters for Symbols Used in the ‘Arc’ Test

Table  9



In Figure 8, the results may be somewhat misleading since they are very close.  The length of the arc was 149 pixels so each additional width introduced another 149 errant pixels to the symbol.  So for example in Test Case 2 the Custom distribution could accommodate 298 more damaged pixels than the Row-Major, Random 1 and Random 2 distributions and 447 more damaged pixels than the Random 3 distribution.  With this in mind there is no clear winner here.  It appears to be a tie between Row-Major order and Custom since they take turns as the best.  The Random distributions always lag
 behind but consistency is again on their side.
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IV. b. Holes



Holes would occur if something was to puncture the symbol.  They are approximately round in shape and vary in size.  An example hole is shown in Figure 9.



�

Example of a Hole in the Symbol
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This test was done by inserting successively bigger circles into the symbol until the error correction mechanism could no longer fully recover all data accurately.  The results of this test are in Figure 10.  Several different symbol sizes were used in testing.  Each symbol size used a different error correction level.  The parameters for the symbols used are shown in Table 9.  Again, comparison between the 
test case
 results may not show anything substantial since the error correction level is different.  Comparisons should be done within the results of each 
test ca
s
e
.





Test Case�Symbol Columns

(in chunks)�Error Level�Number of Codewords�Symbol  Width

(pixels)�Symbol Height

(pixels)��1�10�2�36�300�62��2�13�7�49�390�65��3�17�1�34�510�34��4�23�6�46�690�34��

Parameters for Symbols Used in the ‘Hole’ Test

Table  9







Two of the symbol size and error correction combinations were used to illustrate a weakness of the Row-Major approach.  This weakness occurs when chunks of the same codeword line up in order in a column or on a diagonal.  In the case of the symbols of size 17 and 23 codewords in test cases 3 and 4, respectively, this is demonstrated.  The number of codewords is a multiple of the number of columns and causes chunks to line up in column fashion.  This weakness is evident in their performance when recovering from errors.



The Random distributions perform the most consistently but are 
again 
only average
 performers
.  The Custom distribution always performs at the top in terms of error recovery ability in this test.  The Row-major distribution performs above the Random distribution except when it is set up to fail as previously described.
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IV. c. Cuts

�Cuts happen where a portion of the symbol is chopped off.  In this situation one end of the symbol may be entirely missing.  It has been assumed that the size of the missing portion of the symbol is known and the side of the symbol that it is missing from is also known.  This may or may not be realistic but is necessary to continue this test.  To test the effect of a cut on the symbol, columns of pixels were 
successively 
removed from the symbol until the error correction mechanism could no longer recover data accurately.



�

Example of Symbol that is Cut
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The
 symbol
 parameters used when 
for this 
defect
 are in Table 10.  Again, each symbol used has a different error correction level.  Test cases 3 and 5 are setup to surface the problems with the Row-major distribution due 
to 
the reasons already described.



Row-major form performs horribly in the cases where it was expected.    Since the cut goes in the direction that the codeword chunks line up in this is what was expected.  The different parameters seem to have little effect on the Custom pattern as it always provides good results, either the best or tied for that position.  The Random patterns again gives only average results but usually consistent results from one pattern to the next.�
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Test Case�Symbol Columns

(in chunks)�Error Level�Number of Codewords�Symbol  Width

(pixels)�Symbol Height

(pixels)��1�3�2�36�90�204��2�10�3�36�300�65��3�17�1�34�510�34��4�19�7�49�570�44��5�23�6�46�690�34��Parameters for Symbols Used in the ‘Cut’ Test

Table  10



V. Conclusions

The goal of this project was to determine distribution patterns for the C2DB symbol and to evaluate the effectiveness of each.  Of the three types, Row-major, Custom and Pseudo-Random, Custom seemed the most robust leading the pack in terms of ability to recover from errors in almost every area.  As expected the Pseudo-Random patterns were the most consistent never failing miserably but 
they were 
never the leader.  This was surprising.  It was assumed that the random distributions would not only be stable but also the most robust since they was not susceptible to ‘patterns’ like the formula-based distributions of Row-major and Custom.  Row-major performed as expected; recovering well in most cases but it could be hurt in situations that took advantage of the patterns that are very prevalent with it.



Execution of the test cases was very time intensive.  Since there was nothing unusual about the errors introduced into the symbols it was realized that they could have been programmatically generated and the iterative process of finding the limits would have been much quicker.  Had time allowed th
is feature would be a must have and would have allowed for more test cases to be used.
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